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n  O número de transistores em um circuito integrado dobra                               
a cada 18 meses. (Moore) 

n  Projetar sistemas cada vez mais complexos em uma mesma 
pastilha (Ex: SoCs, MPSoCs) 

n  Propicia aplicações digitais agregar cada vez mais funcionalidade 
em equipamentos de menor volume (Ex: 22nm)  

Fonte : Intel www.intel.com.  2011 
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n  PCMOS = Pstatic + Pdynamic 

n  Componente dinâmica 
n  Carga e descarga de capacitores (Ip,In) 

n  Durante a transição de baixo para alto uma energia 
E=CV2

d d   é drenada de Vdd através de Ip uma parte 
da qual é armazenada em C. 

n  Durante a transição de alto para baixo, a capacitância 
de saída é descarregada através de In. 

n  Corrente de curto circuito (Isc) 
n  Ex: Quando a entrada de um inversor CMOS chaveia 

de um nível lógico para o oposto, haverá um instante 
em que ambos os transistores pMOS e nMOS estarão 
ativados. 

n  Durante este tempo uma corrente Isc fluirá de Vdd para 
Gnd. 

Fonte : Advanced Memory Optimization Techniques for Low-
Power Embedded Processors, Springer  2006. 
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Componentes de Potência 
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n  PCMOS = Pstatic + Pdynamic 

n  Componente Estática (Ilk) 
n  Ilk = pMOS e nMOS não são isoladores 

perfeitos, com isso, há sempre uma 
corrente de leakage que flui de Vdd para 
Gnd. 

n  Ela é inversamente proporcional a 
característica de tamanho e exponen- 
cialmente a tensão de threshold (Vt). 

n  Ex: Ilk = 10-20pA/transis (130nm; 0,7Vt) 

n  Ex: Ilk = 10-20nA/transis (130nm; 0,3Vt) 

n  Leakage Power: 
n  5% when (0,25µm = 250nm) 

n  20-25% (130nm) 
Fonte : Advanced Memory Optimization Techniques for Low-

Power Embedded Processors, Springer  2006. 

Aumento Exponencial 
na corrente de 

subthresold (Ilk) 
ERAD-SP / 2011 
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Redução de Tensão 
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n  Fontes de tensão Vdd                        
reduzidas para controlar a 
potência dinâmica. 

 

n  Isso fez com que reduzisse as 
escalas de tensão de threshold Vth 
para aumentar a capacidade de 
fornecimento de corrente. 

n  Redução de Vth → aumento da 
corrente de subthreshold (ISUB). 

V T = Threshold Voltage 
V GS = Gate-source Voltage 
V TH = Thermal Voltage 

Ex: Ilk = 10-20pA/transis (130nm; 0,7Vt) 
Ex: Ilk = 10-20nA/transis (130nm; 0,3Vt) 

ERAD-SP / 2011 



+
Tamanho do Canal 
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Node 90nm 65nm 45nm 

Dynamic Power per cm2 1X 1.4X 2X 

Static Power per cm2 1X 2.5X 6.5X 

Total Power per cm2 1X 2X 4X 

n  Redução de tecnologia implica 
em redução de canal 
n  Isso não foi feito sincronizado com as 

reduções de Vdd e Vth. 

n  Espessura do óxido reduzida  Tox 
(aumento de campo elétrico) 

ERAD-SP / 2011 
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Fonte : ITRS – 2010 EDITION - DESIGN 

fOp> 3GHz 
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Multicores  x  Frequência 
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Pesquisas 
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Tendências Consumo Energia 
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n Características 
n  Explosão no consumo de potência 

será considerado um fator crítico 
para o futuro projeto de um SoC. 

n  Rápido crescimento do consumo 
de energia resultará em fatores 
críticos com encapsulamento e 
refrigeração do chip. 

n  Leakage power será muito maior 
que o valor calculado na figura, 
devido ao efeito da temperatura. 

n  Consumo de energia por PE 
diminui de acordo com as 
tendências de tensão e constante 
dielétrica. 

Source: 
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Níveis de Abstração 

n  Maior Nível de Abstração 
n  (+) Mais rápido 

n  (- ) Menor precisão 

n  (+) Menos recursos de 
computação para avaliar 

n  Menor Nível de Abstração 
n  (-) Projetos mais lentos 

n  (+) Maior precisão  

n  (- ) Mais recursos de 
computação para avaliar  
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Arquitetura FPGA  
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   cell logic block (clb) 

I/O logic block 

Interconnection 

More than  
10 million gates 
available 



+
Componentes de Potência em 
FPGA 

•  Pre-Programmed Static (Quiescent) Device Power Consumption:  
–  Potência consumida pelo FPGA antes da programação do dispositivo 

•  Inrush Programming Current  
–  Corrente requerida quando programando um dispositivo até a 

programação completa 

•  Post-Programmed Static Power Consumption  
–  Potência que está sendo consumida pelo dispositivo com frequência  

0 MHz. Muito significante. Devido a grande quantidade de 
transistores (8x a 10x comparado a ASIC sem considerar lógica de 
configuração/multiplexação. 

•  Dynamic Power Consumption  
–  Potência incremental consumida pelo componente de frequência não 

nula (P = kcV2f). Depende do projeto 

ERAD-SP / 2011 
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n  Supondo um sistema com freq = f 

n  fsw = αf, where α = atividade de sinal 

n  Se o sinal é o clk, α = 1 

n  Se o sinal chaveia uma vez por 
ciclo de clock, α = ½ 

n  Potencia dinâmica :  
2

dynamic DDP CV fα=
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Potência Estática 
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n  FPGA utiliza mais transistores que os ASICs, devido a lógica 
de reconfiguração consumindo muito mais potencia estática 
para uma mesma funcionalidade.  

n  A potencia estática aumenta significativamente com a 
temperatura 

n  Uma grande parte da potência consumida é devido a partes 
não usadas do FPGA. 

Tech = 90nm 



+
Calor  x  Atividade Chaveamento 
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n  Obter uma nova estratégia de 
administração da temperatura de 
um FPGA. 

n  Sugere-se chegar a uma redistribuição 
da potência por todo o dispositivo de 
forma “balanceada” (através da 
redistribuição da atividade de 
chaveamento) 
n  reduzindo o número e a amplitude dos 

picos de dissipãção de potência. 
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Atividade Chaveamento FPGA 
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n  Redução de 15% no valor médio 
da temperatura 

n  Redução da temperatura nos 
hotspots (33% aproximado) 

n  Uso de algoritmo EX-VPR,                    
In: Siozios, et al., “A Novel Methodology 
for Temperature-Aware Placement and 
Routing of FPGAs”, ISVLSI 2007. 
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Comparação Potência FPGAs 
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Source: WP298: Power Consumption at 40 and 
45nm -  13 Abril 2009 
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Fluxo de Estimativa 

n  O fluxo para estimativa de energia pode ser resumido de 
acordo com a figura abaixo. 

n  Foi usado como base o ambiente da Altera e PowerPlay 

ERAD-SP / 2011 
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+
Fluxo de Estimativa 

•  Deve-se criar a estrutura para estimular as entradas do 
módulo que se deseja estimar o consumo de potência 
•  Gerador de estímulos 
•  Top que interliga o módulo ao gerador de estímulos 

ERAD-SP / 2011 
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IP-CORE 
GERADOR 

DE 
ESTÍMULOS 

TOP 



+
Fluxo de Estimativa 

•  Maior Cobertura de Testes 
•  Testes Randômicos executados mais facilmente 
•  Maior automatização no processo de testes 
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+
Fluxo de Estimativa 

•  Criando o projeto na ferramenta de Simulação Modelsim 
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File → New → Project 
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Fluxo de Estimativa 

•  Criando o projeto na ferramenta ModelSim 
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Configure nome e local do projeto 
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Fluxo de Estimativa 

•  Adicionando IPs 
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Adionar ao projeto os RTLs             
do projeto 

Configurar Nome e Local 
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Fluxo de Estimativa 

•  Compilar códigos no ModelSim 
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Compile → Compile All 
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Fluxo de Estimativa 

•  Simular o projeto 
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Simulate → Start Simulation 
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Fluxo de Estimativa 

•  Na janela “Start Simulation”, selecione no package “work” o 
arquivo Top Level comentado no início e pressione OK 

ERAD-SP / 2011 
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+
Fluxo de Estimativa 

•  Clique com o botão 
direito no top de seu 
projeto e em seguida 
selecione Add → To Wave 
→ All items in design 

ERAD-SP / 2011 
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+
Fluxo de Estimativa 

•  A janela “Wave” será aberta com os sinais adicionados no 
passo anterior. No campo em destaque abaixo, coloque o 
tempo de simulação e clique em “Run”. 
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+
Fluxo de Estimativa 

•  A janela “Wave” será aberta com os sinais adicionados no 
passo anterior. No campo em destaque abaixo, coloque o 
tempo de simulação e clique em “Run”. 
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+
Fluxo de Estimativa 

•  Feche o projeto na janela “Transcript” com o comando:                                 
“quit-sim” 

•  Crie o arquivo “.vcd” com o comando :                                         
“wlf2vcd –o ‘nomedoarquivo’.vcd vsim.wlf” 

ERAD-SP / 2011 
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+
Fluxo de Estimativa 

•  Crie um novo projeto no Quartus II                                                               
File → New Project Wizard  

ERAD-SP / 2011 
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•  Isso irá abrir a janela “New Project Wizard” para adicionar 
o nome,  local do projeto e arquivos fonte 
•  O nome do projeto deverá ser o top level do módulo 
•  Aqui NÃO deve ser adicionado o gerador de entradas e o top que os 

interliga 
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Fluxo de Estimativa 

•  Etapa de Síntese do Projeto :                                                                
Processing → Start Compilation 

ERAD-SP / 2011 
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+
Fluxo de Estimativa 

•  Inicie o PowerPlay Analyzer Tool 
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Processing → PowerPlay Analyzer Tool 
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Fluxo de Estimativa 

•  Com o PowerPlay  aberto, clique em: “Add Power Input File”.                  
Isso irá abrir a janela “Settings” 
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+
Fluxo de Estimativa 

•  Clique em “Add” para adicionar o arquivo “.vcd”                                              
que foi gerado no ModelSim.  

•  Configure os dados da Janela “Add Power Input File” que abrirá 
em seguida. 

ERAD-SP / 2011 

38 



+
Fluxo de Estimativa 

•  Após tudo configurado, inicie a simulação do PowerPlay                         
clicando em “Start” 
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+
Fluxo de Estimativa 

•  Clique em “Report” para ver o resultado da estimativa de 
consumo de potência 

ERAD-SP / 2011 
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Plataforma   x   Precisão 
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n  Aplicações de Segurança 

n  MD5, DES, DES3, AES 

n  3 Placas Comerciais 

n  Precisão das placas 
ainda bastante baixas 
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Plataforma   x   Precisão 
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n  Diferentes planos de 
potência 

n  Shunt para medir 
potência na PCIe 

n  Shunt para medir 
potência na Fonte 
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Redução de Energia 
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n  Gated Clock 
n  Figura 1 indicando que pode levar 

a clock glitches. 
n  Figura 2 indicando solução 

síncrona para evitar glitches 
n  Enable=1, carrega novo dado 

 

Gated Clock 
1

2
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Redução de Energia 
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n  MSV (Multiple Supply Voltage) 
n  Distintas tensões de alimentação 

MSV 
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Redução de Energia 
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n  Power Gating 
n  Reduzir atividade de chaveamento de 

sinais indesejáveis 

Power Gating 
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Redução de Energia 

ERAD-SP / 2011 

46 

n  DVS (Dynamic Voltage Scaling) 
n  DFS (Dynamic Frequency Scaling) 
n  DVFS (Dynamic Voltage Frequency Scaling) 

   DVS 

20MHz 30MHz 10MHz 20MHz 

Power 
DFS 
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Redução de Energia 
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Low Power Workshop Attendees’ Survey, 2007  
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Aplicação 

n  Aquisição de dados no mar. 
n  O “source” periodicamente 

gera ondas que produzem 
reflexões na borda da 
superfície que são em seguida 
coletados por “receivers”. 

n  Processo de Migração Sísmica 
para produzir uma imagem do 
subterrâneo consistente com os 
dados adquiridos. 
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Fonte : PETROBRAS, “Computational Characteristics of 
Production Seismic Migration and its Performance on Novel 
Processor Architectures”, SBAC-PAD 2007. 
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Aplicação 

n  Ambiente Experimental 
n  Host Intel Core 2 Quad 
n  Placa Gidel DDR2, FPGA Altera 

Stratix III 260E 
n   512MB SDRAM, 2 SODIMM de 

8GB cada uma. 
n  Uso da PowerPlay Analyzer Tool 
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Aplicação 

n  Metodologia  
n  Altera Quartus II 
n  ModelSim 
n  PowerPlay Analyzer Tool 
n  Gidel  PROCStar 
n  Marmousi 
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Verilog (QuartusII)
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